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1. What is Edge Box HMI?

With the Edge Box HMI, you can collect data from connected devices and forward it to
Machine Advisor / AVEVA Insight / External Database with easy settings on software.

e AVEVA™
InSight

-

EcoStruxure
Machine Advisor

Pro-face
Edge Box

PLC Temp Inverter

About this document

This Edge Box HMI Quick Start Guide is intended for individuals using Edge Box HMI and its
software for the first time. This document will help you quickly familiarize yourself with basic
use of this product.
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2. Preparation

Required environment

Prepare the following development environment.

(B)

USB Cable
or

Proface

Bdu_;;en Studio

LAN Cable

BLUE Open Studio

STM6000 Edge Box HMI
PFXSTM6B00DIOT pC

(A) STM6000 Edge Box HMI (PFXSTM6B00DIOT)

(B) Transfer Cable
I / Optional USB transfer cable (PFXZUSCBMB2) or commercial
o ¢ USB cable (Type A to Micro-B).
\f(\\ﬁﬁl LAN cable (Ethernet cable)

(C) PC with BLUE Open Studio

You PC (development environment) requires a HTML5 compatible browser (recommended:
Google Chrome) to be installed.

To create HMI project and transfer to the Edge Box HMI, your PC also requires BLUE Open
Studio 2020 SP2 or later to be installed. BLUE Open Studio 500 tags Build Time License
(PFXBOSBTS500A) is sold separately.
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3. Hardware Configuration
This procedure is intended for users who are transferring a project to the Edge Box HMI for

the first time. After this setup, you can access the Hardware Configuration page on a web
browser to configure the Edge Box HMI.

=

JAVAVA JAVAT FAVATVA

SRREEREAte

00 \ZAVAVAY
'AVA',\'A'A

. :?xs'\#""‘ IA'A'A'T;’A"

s Ethernet
uv&lﬁ#{ﬁ#{ﬁﬂﬁ#
Gowt) ) ] Or USB

......

Hardware Configuration page
on a web browser

1. Connect Power Supply (DC24V) and check the status LED flashes orange.

2. Connect PC via Ethernet cable or USB cable.

3. When Ethernet (ETH1) is used, set IP address of your
PC as follows.

Internet Protocol Version 4 (TCP/IPv4) Properties  *

General
IP address: 192.168.1.*** e capeity. it o nead 1o Yo etk bt
(any address other than 192.168.1.80)
Subnet Mask: 255.255.255.0 O
1P address:
Subnet mask:
When USB is used, the Edge Box HMI is recognized Defait gatevay: 26811
as Ethernet deV|Ce on your PC and |P addl’eSS |S Obtain DNS server address automatically
automatically configured. f::::;‘:::f;fs ““E
(Device name: Remote NDIS Compatible Device) lsnate OV server: . 1
[ validate settings upen exit Advanced. .

OK Cancel
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3. Hardware Configuration

4. Open a web browser on your PC, and in the address bar enter the IP address of Edge
Box HMI.

https://192.168.1.80 (Ethernet)
https://169.254.100.100 (USB)
Hardware Configuration screen is displayed.

5. When you access to the screen for the first time, you are requested to set a login
password.

Set a login password and click [Submit]. e.g. !Proface1234, and click [ Submit ]
Note: The user name is “Admins” and cannot be changed

el
Hardware Configuration -
Version 10 T Enter Password
‘ Confirm Password ‘

Pro-face

/The password must meet the following requirements: \
Number of At least 8 single-byte characters, up to 64 characters
characters

Types of Use at least one of each of the following types of
characters characters:

*» Uppercase letter (A-Z)

 Lowercase letter (a-z)

* Number (0-9)

» Symbol (special character): ! # - = _

© 2021 Schneider Electric Japan Holdings Ltd. All Rights Reserved.

Note: If you forget the password, note that you will not be able to reset it. To
restore the product to its original state (at time of purchase), contact customer
&upport. All user data in the product will be lost. /

6 v1.0
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3. Hardware Configuration

6. Enter the User Name, Admins and the newly created password, e.g. |Proface1234. Click
[ Login ]

Login

Admins

Hardware Configuration

INFORMATION ETHERNET com usB DOWNLOAD SITEMANAGER SECURITY SYSTEM
System Status

Status Runtime does not exist. Or, Waiting for download. Please download runtime
System Version 10.11

Runtime Version ~ —---—-—-

ProjectFile  —oeooee

Ethernet 1

1P Mode Manual

1P Address 192.168.1.80 255.255.255.0

MACAddress 00:80:F4:A2:2D:41

Ethernet 2

IP Mode Disabled

IP Address 0.0.0.0 00.00

MACAddress 00:80:F4:A2:2D:42

7. If you will be using an internet connection for cloud connectivity please proceed to step 8.
If no internet/cloud connection needed please skip to step 12.

Click [ ETHERNET] to display the Ethernet settings.
Click [ Ethernet 2 ] to display Ethernet port 2 settings.

Hardware Configuration

INFORMATION ETHERNET

IP Mode *

DOWNLOAD SITEMANAGER SECURITY SYSTEM

‘ Disabled

IP Address

Default Gateway

MAC Address

00:80:F4:A2:20:42

Subnet Mask

5.255.255.0
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3. Hardware Configuration

10. Setthe [ IP Mode] to [ Automatic ] or [ Manual] . [ Automatic ] for DHCP or [ Manual ] to
enter in the necessary settings to allow internet access.

Hardware Configuration

INFORMATION ETHERNET COM uUsB DOWNLOAD SITEMANAGER SECURITY SYSTEM

Ethernet1l Ethernet 2

IP Mode *
Automatic - ]

IP Address Subnet Mask
192.168.2.80 255.255.255.0

Default Gateway

MAC Address

00:80:F4:A2:2D:42

11. Click [ Submit] to apply the ethernet setting. Note that the settings will only take effect
after a reboot. [ OK ] to dismiss the Reboot Required dialog.

Reboot Required

o Changes will take effect after reboot
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3. Hardware Configuration

12. Click [ DOWNLOAD ].

Hardware Configuration

INFORMATION ETHERNET DOWNLOAD SEANAGER SECURITY SYSTEM

[Enable Project File Download ]

@ If the download is enabled, the thorized access and infection of malicious software increases. Disable download after use

13. Check [ Enable Project File Download ]
14. Click [ Submit]. Changes will take effect after a reboot.
15. Click [ OK ] to accept the Reboot required message.

Reboot Required

o Changes will take effect after reboot

16. Click [ SYSTEM ]

Hardware Configuration 1 6

INFORMATION ETHERNET DOWNLOAD SITEMANAGER SECURITY SYSTEM

Enable Project File Download

@) If the download is enabled, the risk of unauthorized access and infection of malicious software increases. Disable download after use
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3. Hardware Configuration

17. Setthe [ Date ], [ Time ], [ Time-zone ] for your region.

Hardware Configuration

INFORMATION ETHERNET DOWNLOAD SITEMANAGER

Date and Time Firmware Update Factory Reset Backup and Restore Configuration

Date
D s

2022-04-12

Time

05:56:00 PM

Time-zone

(UTC-04:00) Canada/Eastern

Synchronized with NTP Server [ |
NTP Server

SECURITY

SYSTEM

18. Click [ Submit ], changes will take effect after reboot.

19. Click [ OK] to dismiss the Reboot Required dialog.

Reboot Required

o Changes will take effect after reboot
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3. Hardware Configuration

20. Click the [ Reboot ] icon {ljlat the top right of the web page.

bad after use

21. Click [ Yes ] in the Reboot dialog.

Reboot

e Are you sure you want to reboot?

22. After the Edge Box HMI has rebooted. Confirm the [ Ethernet 2 ] Settings, [ Enable Project
File Download ] check box, [ Date ], [ Time ], [ Time-zone ] are as previously selected.
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3. Hardware Co

nfiguration

Hardware Configuratior

INFORMATION

System Status

Status

N

ETHERNET COM usB DOWNLOAD SITEMANAGER SECURITY SYSTEM

Runtime does not exist. Or, Waiting for download. Please download runtime.

System Version 1.0.11

Runtime Version =~ -—cooo-

Project File =~ —coeoeo

Ethernet 1

IP Mode Manual

IP Address 192.168.1.80 255.255.255.0

MACAddress 00:80:F4:A2:2D:41
(Ethernet 2

IP Mode Automatic

IP Address 175.172.0.225 255.255.255.0

MACAddress 00:80:F4:A2:2D:42

Hardware Configuration

INFORMATION

ETHERNET

DOWNLOAD SITEMANAGER SECURITY SYSTEM

[ Enable Project File Download

)

@ If the download is enabled, the risk o

ed access and infection of malicious software increases. Disable download after use

Hardware Configuration

INFORMATION

Date and Time

Firmware Update

ETHERNET TEMANAGER SECURITY SYSTEM

Factory Reset

Backup and Restore Configuration

~

‘ 2022-04-12 ‘
Time

‘ 05:56:00 PM @‘
Time-zone

NTP Server

‘ (UTC-04:00) Canada/Eastern - y
Synchronized wi erver ||
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3. Hardware Configuration

In the Hardware Configuration screen, you can configure the following settings of the Edge

Box HMI.

Function name

INFORMATION

ETHERNET

COM

usB

DOWNLOAD

SITEMANAGER

SECURITY

SYSTEM

Hardware Configuration ICRES

INFORMATION

ETHERNET CcoM usB DOWNLOAD SITEMANAGER SECURITY SYSTEM

System Status

Status Runtime does not exist. Or, Waiting for download. Please download runtime.
System Version 1010
Runtime Version -

ProjectFile ~ —oeeeoee

Ethernet 1

IP Mode Manual
IP Address. 192.168.1.80 255.255.255.0

MACAddress 00:80:F4:A2:2D:4D

Ethernet 2

IP Mode Disabled
IP Address 0.0.00 0000

MACAddress 00:80:F4:A2:2D:4E

Description

You can check the product system version, runtime version, IP address, and so on.
Also, if a System Error/Runtime Error occurs, you can check the error information in
[Status] area.

Configure Ethernet settings, which are required when communicating over Ethernet
with connected devices, or when using functions that interact with a network PC,
such as downloading project files.

Select the serial interface communication method as either RS-232C or RS-422/485.
For RS-232C communication, you can select to enable or disable VCC.

When a USB device is connected to this product, use this function to safely remove
the hardware.

Enable to download project files and HMI Runtime to this product. Disable this setting
for active run time operation.
NOTE: Enable only when downloading project files or HMI Runtime.

Set up when configuring a system that includes Pro-face Connect (sold separately).

Change the password. You can also perform operations such as check the previous
login information and download that information. The downloaded security data file is
"log.csv".

[Date and Time] tab: set the internal clock of the product. You can also set up an
NTP server to synchronize the clock.

[Firmware Update] tab: update the firmware.

[Factory Reset] tab: you can reset the product to the factory default settings.
[Backup and Restore Configuration] tab: you can back up the settings in Hardware
Configuration. The downloaded backup data file is "config.bin". You can also use the
backup file to restore the settings of Hardware Configuration.

NOTE: The following settings are not backed up or restored.
* SECURITY tab
» Date and Time tab in the SYSTEM tab




4. HMI Project Creation

1.

Context Help Communication
Sensitive Drivers

Documentation

Project Explorer

~ & Project: PCDemo.APP
> Screens
> Screen Group
> Thin Clients
> Project Symbols
L' Graphics Script
@ Mative Symbols

[H Layout

Insert Praoject Help

(7 Ce E <& H]

License  Product Release Support About
Agreement Web Site  MNotes

STM6000 Edge Box HMI Quick Start Guide

Create Project

Start up BLUE Open Studio 2020 SP2 or later and click [File] > [New].

@, Industrial Graphics Symbols

Information

2.  Enter your [Project Name], e.g. EdgeBoxHMI QuickStart.

3.  Select Project type [Embedded BLUE Open Studio Basic] and click [OK].

Project  File 4 Pk
a’ﬂ Create new Project with the specified settings
Project name:
EdgeBoxHMI QuickStart
C\sers\PFX\Documents\BLUE Open Studio 2020 Projes Browse

New

Configuration file:
C:\Users\PFX\Documents\BLUE Open Studio 2020 Projects\EdgeBoxHMI QuickStartiEdgeB.

Target platform®* (1))

Product type*

Windows BLUE Open Studio Supervision

Windaws BLUE Open Studio Line Wanagement Pluf{ Embedded BLUE Open Studio Basic ))
Windows BLUE Open Studio Line M; t

Embedded BLUE Open Studio Line Management
4

BLUE Open Studio Basic for Linux (500 tags)

*Select Windows target platform for Windows Server/Desktop projects. Select Embedded target
platform for Windows Embedded and HMI Runtime projects (Windows Embedded Compact (Windows
CE), Windows Mobile, Linux, etc.).

*¥'ou can modify the target platform and product type after creating the project by using the Project tab.

Cancel

4.  Select resolution (you can use any) and click [OK].

Project Wizard

Display
Resolution: Width Height:
Custom = 1920 1080

C)

New
Open Project

Open Project File

Save All As HTML
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4. HMI Project Creation

Create Project

5.  Check or uncheck the “Do not automatically...” as appropriate.
6. Click [Next]

Overview

x

Stepl/6 W]

This wizard will help you to configure the new Security System.

These are the cument securty settings: Users Groups:

Security System is enabled Guest Guest

[Local Mode]

[Local Mode]: GOOD

‘ | Do not automaticaly show this wizard next time you open Secua

==

7.

Clear the check box of [Enable Security System].
8.

Click [Next] several times to skip Security Settings.
9.  Click [Finish] on the last dialog box.

Enable Security System

x
< Step 2/6 [ — <«

Step 6/6 N

Do you wish to enable Security system?

' Erable Sacurity Svster ’

Configuration Wizard results:

Security system not enabled | Guest Guest

[Local Mode]

[Local Mode]: GOOD

Einish

NOTE: You can configure security system later. So, skip here for quick start.
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4. HMI Project Creation
Create Screen and Tag

1.  Select [Graphics] Tab.
2. Right-click on [Screens] and select [Insert].
3.  Click [OK] on the Screen Attributes dialog.

File Home View Insert Project Help

X Cut =] P Run 1 Download [ —
D [ cop i@; W stop (@) . :: @

3 Connect e Watch LogWin
Debug ~
Clipboard (]
3 Descriptiors
Project Explo
Background Picturs Size Location
v iactabdge! []Enable Background e - Width: 640 Top: |0
Screen Fieed e I:l Height | 420 Left: | g
aa Insert ) -
e e Rurtime Propertiss Security
> in Cli nsert Industrial Graphics Screen P ool b
Project
£ save All As HTML S Style: |Replace(Partia) || Sereen Logic
L Graphic Maximize Bax o s
- i T } order: | None - On Open
@ Native Symbols Minimize Box g B
: . Don't redran: While Open
@; Industrial Graphics Symbols ont e
On Close,
[ Layout Disable
Focus Pertormance Opg
Receive focus an open Tab Order. []Hide screen
[v]Share tab order with other screens o [ Keep sereen
[ Bsckeround scresn
(

2% Comm

Double-Click [Native Symbols].
Expand [System Symbols].
Select [Sliders]. =

Select [slider01], the mouse icon should change to !

BLUE Open Studio - Symbols

File Home View Insert Project Help Style ™
X cut ™ P Run 4 Download [Z = 5 Import Wizard — ab 32 Replace
0 e % @ = ®[a] [v] - =
[ cop Run £32 Convert Resolution <% Remove unused tags 7
Paste Runti untime Watch LogWin | Verify Archive  Global
SO Find/Replace  Tas W Stop Ta B Register Controls Replace (@] Resettags dstabase (1 F
Clipboard Remote Management [ Tools [ Tags
Project Explorer peenz. @ Symbols x -
v £l Project: EdgeBoxHMI Qui Symbols ~
Screens e
Screen Group A
> W Thin Clients s Ml Arrows T —
Project Symbols > Ml Bagiaphs T E
> ¥ Buildingéutomation T |
> Buttons 4 -
> Command =
< o
5 ¥ DateTime B w * * L B
> W Ducts Minimal_BlackSliderL... Minimal_BlackSliderL... Minimal_WhiteSlider... Minimal WhiteSlider... slider01 slider02 sliderD3
> Faceplates
> Fans "
> 0 leans H o '] L]
> 1 Indicatars @ a
: = | —
Mators
PilatLights
Fipes = =
Flates slider04 slider0s slider06 sliderd7 slider0s slider09 slider10
Fumps
" L]
Sliders = ﬂ =y E
; v
/2 Global | (& Graphics | 2| Tasks 22 Comm Tanks v« >
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4. HMI Project Creation

Create Screen and Tag

8.  With the mouse cursor still as

newly created screen again. E“:
9.

De-BO-»ed-

File Home Proje

1 |
}' & - ,"_}iﬂDisable Drag '
Attributes Script
H ?

Editing

View Insert

g Selection ~

3 Replace

Screen
Project Explorer 7

- X

v & Project: EdgeBoxHMI QuickStart. APP

Screens
Screen Group
> Thin Clients
> Project Syrmbols

B Graphics Script

@ Native Symbols

B, Industrial Graphics Symbols
[H Layout

click on the new screen’s tab, which will show the

Click anywhere on the screen to drop the slider01 symbol.

Draw Tools
ct Draw Help
— *\, Line [ Rectangle
Q Open Polygon (O Rounded Rectangle
() Closed Polygon O Ellipse
Shapes
|;|S(Ieen2 4 @\Symbols

;

10. Double-click the newly created slider01
dialog.

11.

symbol which will open the [Object Properties]

Double-click the [TagName] [Value] field which will open the [Object Finder].

Object Properties

¥» Replace.. Hirt: Linked Symbol
Mame  Slders\eliderdt.sym [ Use linked size Expand
Category Display properties from all categories
Main Property Value
T Max 100
[T Min 0

| p——

|aF Taghlame (

)
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4. HMI Project Creation

Create Screen and Tag

12. Click [New].

Object Finder

Selection:

& Tags Name Description

=] Project
|.I Booleai
|aF Integer
| Real
String
B Class

System

4 4

Source Status

13. Enter a [Name], e.g. MyData.
14. Set the [Type] to [Integer].
15. Click [OK] to create the new tag.

Mame: ( MyData

Array: 0
Type: Integer -
Description:
Scope: Server -
QK | Cancel |

16. Select [Project] and select the newly created tag, e.g. MyData.
17. Click [OK] to close the [Object Finder].

Object Finder

Selection: | MyData

ey
| Project
Baaffeal

Description

= @s

4

Source Status




4. HMI Project Creation

Create Screen and Tag

STM6000 Edge Box HMI Quick Start Guide

18. Close the [Object Properties] window

Object Properties

X

Replace ..

Category:

Main

19. Click the [Save] Icon

Vi

Screen

Project Explorer

Name = Slders\slider01.sym

Hint:

Display properties from all categories

| Use linked size

Linked Symbol
Expand

ew Insert

Project Drﬂ Help
g Selection ~ — \ Line [ Rectangle
.';j Disable Drag ?’é < Q Open Polygon (O Rounded Rectangle
(22 Replace 7 (™) Closed Polygon O Ellipse
Editing Shapes
- I x |;| Screen?2 X @ Symbols

Property Value
lF Max 100
|oF Min ]

Draw Tools

v & Project: EdgeBoxHMI QuickStart. APP
Screens
Screen Group
> Thin Clients
> Project Symbols
& Graphics Script
@ Mative Symbols
% Industrial Graphics Symbols
[H Layout

100%_

g

20. Set the [File name] to Main.scc then click [Save]

[':] Save As X
L < EdgeBoxHM... » Screen v [¢] S Search Screen
Organize = Mew folder Bz - 0
S
() MName Date modified Type
3 Quick access
[ Desktop * No iterns match your search.
* Downloads
Documents o
Pict
[&] Pictures » wlz Y
File nare: ‘ Main.scc ) v
Save as type: | Screen Files (*.scc) ~
A Hide Folders ‘ Cancel
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4. HMI Project Creation

Mobile Access Configuration
Close all open tabs. E.g. Main.scc, Symbols

1.
2.  Right-Click [Screens] and click [Save All as HTML]
File Hoﬁ View Insert Project Draw Help
X = P Run + = —
O o @ SO
,O BT R#:::Lr:e & Emm Connect Watch LogWin
Clipboard Local Management e Remote Management (]

> O x

Project Explorer
eBoxHMI QuickStart.APP

v 5| Sy q
3
= Insert
Insert Industrial Graphics Screen

in Cli
We|
MALEy Save Al As HTML

)

roject Symbols
Graphics Script

@ Mative Symbols

B, Industrial Graphics Symbols

[H Layout

P Global | [ Graphics | =] Tasks E2 Comm

3. If prompted, click [Yes]

@% To use this functionality the TCP/IP Server
module needs to be enabled, are you sure that

- -4
you want to enable?

Mo

4. If prompted again, click [OK]
4

ELUE Open Studio

In case you want increased security, restricting the
access to your project over the Web, you can

A
configure it under the Project group, Web settings.
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4. HMI Project Creation

Mobile Access Configuration

5.
6.

Open [Thin Clients] and double-click [Mobile Access]

If prompted with a dialog, select [Yes], the [Mobile Access Configuration] is shown

Project Explorer

- 1

x

~ &l Project: EdgeBoxHMI
Screens

Screen Group

€ Web

(1| Mobile Access

Project Symbols
ET Graphics Script
@ Mative Symbols
4, Industrial Graphics Symbols
[H Layout

.,ﬁm Global | [&] Graphics %8 Comm

File Home View Insert Project Help
X =™ P Run @D A+ o @ @ 7 % Import Wizard — [)ab @2 Replace
= - _|l'
|:| M @ M Stop £ Convert Resolution AC 7 Remove unused]
Runtime Connect Watch LogWin Verify Archive Global
,D Find/Replace Tasks & Debug -~ Egg Register Controls Replace '@ Reset tags datab)|
Clipboard Local Management = Remote Management L] Tools [P

en Studio

Please note the Maobile Access feature is not supported for
Windows Embedded Compact. For the Target System you
selected Mobile Access will be available for either Windows
Embedded Standard or HMI Runtime. Do you want to continue?

0=

7.

Click [Area Settings...]

File Home View Insert Project Help
X =] P Run @ i = @® @ 7 % Import Wizard l?l [)ab (&2 Replace &
D [Tk} _© W Stop = 2 Convert Resolution I—I AC o nemove unused tags 2
Runtime Connect Watch LogWin | Verify Archive  Glabal
JSOFindReplace  Tasks B Debug ~ R, Register Controls Replace @) Resettags database E°
Clipboard Local Management T& Remote Management [+ Tools [ Tags
Project EXD'OT’ET’ - 1 x ;'Screenz @Symbms Mobile Access Configuration X

v & Project: EdgeBoxHMI QuickStart.APP
Screens

Process Values

Screen Group
v Thin Clients

Update Rate (ms): | 1000

Update Rate After Command (ms): | 100 Update Count After Command: |5

@ Web
Mobile Access

Project Symbols

B Graphics Script

@ Native Symbols

B Industrial Graphics Symbols

Session Expiration (s):

Background Color: ©

Zoom Mode:

Align: !:l Center -

Auto Screen Scaling Enable Hide For All Screens Max Hidden Screens: |32

Always Use Data Input Dialog Enable CGI

User Experience

[B Layout

Initial Events Timeout (ms): | 100

Standby Start (ms): | 500 Standby Timeout (ms): | 10000

Browser Logs

Error [1 Wamning

Runtime Comm Screen

[ Information [ Trace Verbosity: | 1(Less Messages) -

Web Services

= Tasks

£ Global |[Z] Graphics 2% Comm

Area Settings..

Tagj
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Mobile Access Configuration

STM6000 Edge Box HMI Quick Start Guide

8.  Scroll down to the [Trend and Process Values] section
9. Enter “MyData” for the [Tag Name] and the [Label].

10. Check the [Write] checkbox

Mobile Access Configuration X

[1 Show process values alarms only

Trend and Process Values

Tag Name |

MyData MyData
-

Label

Widget

Max|
o 100
o 100
o 100
o 100

None
None
None

None

Widget Size: | Medium

Write Access Level:

Screens

11. Scroll down to the [Screens] section.

12. Select [main] from the first drop dropdown list. Type in the [Label] “Main” in the text box

Mobile Access Configuration =

Widget Size: | Medium

Write Access Level:

0

Screens

Label

Screen
main ¥ AMain

Some objects and functions are not supported in screens, please see the documentation for more details. You must also save your screens as HTML.

Web Settings...
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4. HMI Project Creation

Mobile Access Configuration

13. Click the [Save] icon to save the [Mobile Access Configuration]

Oe{B8lbo-red-

View Insert Project Help
50 ® 5 M3
Ec - Ec V|
G‘.I W Stop © O\ 8 cor
Runtime Connect Watch LogWin Werify
ind/Replace Tasks et Debug ~ BE Rec
Clipboard Local Management s Remote Management [F}
PrOjeCt Explorer - I x Mobile Access Configuration

v & Project: EdgeBoxHMI QuickStart. APP
> Screens
Screen Group
v Thin Clients
@& web
Mohbile Access Widget Size: | Medit
> Project Symbols
B Graphics Seript =
@ Mative Symbols
@ Industrial Graphics Symbols Screen |

[H Layout main Y M

Some chjects and functions are r

#P Global |[3] Graphics | 2] Tasks 22 Comm

14. Close the [Mobile Access Configuration] tab.
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5. Transfer

The Edge Box HMI (model number: PFXSTM6B00DIOT) includes an HMI Runtime license
(500 tags supported) and a Mobile Access license. There is no need to activate them.

Since the Edge Box HMI does not have a display, you can use the Mobile Access feature to
access the Edge Box HMI from a web browser on your computer (development environment).

The following settings are required in BLUE Open Studio to enable transferring a project to the
Edge Box HMI.

Install Runtime Files

1.

2.

On [Home] tab of the ribbon, in [Remote Management] group, click [Connect].

File Home View Insert Project Help
¥ = Run
[ = & -
| W Stop
Runtime Connect
O Find/Replace  Tasks &% Debug -
Clipboard Local Management T«
Project Explorer v 1 x

~ & Project: EdgeBoxHMI QuickStart.APP
> Screens
Screen Group
v Thin Clients
& web
Mobile Access
» Project Symbols
' Graphics Script
@ Mative Symbols
B, Industrial Graphics Symbals
[ Layout

Remote Management I

® []

Watch LogWin

[Target] tab, enter the [Target Station] [Host] IP address of the Edge Box HMI
e.g. 192.168.1.80 (Ethernet cable) e.g. 169.254.100.100 (USB)
3. Click [Connect]

Remote Management

Target Project Import Embedded License

Specify and connect to the target station to install the embe ime
E| software and/or download the project
Target Station
l192.155.1.sn| ] e

* Host:

Flatform:

x

4 bk

Cancel




5. Transfer

STM6000 Edge Box HMI Quick Start Guide

Install Runtime Files

4. If prompted,

click [Yes].

RemotedPl

The Remote Agent does not have security configured. It is
strongly recommended that you enable security on the

Remote Agent. Please refer to the technical reference manual
far information on how to configure the security for the

remote agent.

Do you want connect anyway?

Yes Mo

5. If prompted again, answer either [Yes] or [No] as appropriate.

RemuotelPl

o Unsecure connection. Do not ask again?

O

6. After confirming that the Remote Management tool connected to the Edge Box HMI and
its status is displayed, click [Install Runtime Files].

Remote Management X
Target Project Import Embedded License 4 F
El ?g:tivlf:r:r;i;?grn::t“f:é:zt;]r;;;trg:iélton to install the embedded runtime YOU,” see the Informatlon
in [Status] such as
Target Station T— “Connected to ...”
192.168.1.80 Status:
Connected to remote device (HMI Runtime is .
Install runtime files... Only newer fies Platform:
Linux 5.4.1 DB—rtE-E—timesys_pree

&3 d

Fram 'Ein’ To 'Bin’
TnTWiew

Cancel

.
Note: It will take a while to install HMI Runtime.
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5. Transfer

Transfer Project Files

1. In the [Remote Management] dialog, click the [Project] tab. In the [Local] box, you should
see the location of the project that is currently open in your development environment.
This is the project that is to be downloaded to the Edge Box HMI.

2. Ensure that the [Status] is “Project is stopped”. If not, click [Stop] and wait for the status
to change.

3. Click [Download].

Remote Management

Target{ Project port  Embedded License

bl

Project Path

L
-

project to the target station

Local: \EdgeBoxHM| QuickStarth )

Target: ‘mntsystemiprojecti

Only newer files Run allis,
Project is stopped.
top

| 0

4. After the [Status] has changes to “Files were sent successfully”, click [Run]
5. Click [OK] to close the dialog window.

OK Cancel

Remote Management

Target Project Import Embedded License

."Ij Download the project to the target station

Project Path
Local: | ers\PFX\Documents\BLUE Open Studio 2020 Projects\EdgeBoxHMI QuickStarty

Target: \mnt\systemiproject!

Dowenload... | Only newer files

Stop

Statys-
Files were sent successfully.
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6. Accessing the HMI Screen using Mobile Access

After transferring your HMI project to the Edge Box HMI, launch a web browser on your PC to
access the HMI screen.

1. Launch a web browser on your PC.
2. Access to https://<EdgeBoxHMI IP Address>/MA, e.g. https://192.168.1.80/MA
3. Enter ‘guest’ in username and Click [Logon].

[m] Mobile Access %  + - o x

< @] A Notsecure | Beps//192.168.1.80/MA/ A T 1= ;4

asswora:

4. Click [Screens], then screen list that you configured in Mobile Access worksheet
appears.

[ | (] Mobile Access x IS = o x
& C A Notsecure | haps//192.168.1.80/MA/ A g = s -



https://192.168.1.80/MA
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6. Accessing the HMI Screen using Mobile Access

5. Click screen menu item to see the screen.

() Mobile Access x + - o x Mobile Access o x
C A Notsecure | hetps//192.168.1.80/MA/ A s o= s - < G A Notsecure | hips//192.168.1.80/MA, A s s -

N

AU 1~ a
O,

NOTE: You can go directly to the screen by specifying the screen name in URL.
https://<EdgeBoxHMI IP Address>/MA/#screen=<Screen Name>&guestuser=1

e.g. https://192.168.1.80/MA/#screen=main&guestuser=1



https://192.168.1.80/MA/#screen=main&guestuser=1
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7. EcoStruxure Machine Advisor Configuration

Overview

The Edge Box HMI can use the MACHA driver to send tag data to EcoStruxure Machine
Advisor. An internet connection is required. By default, tag data is sent when the tag value

changes.

NOTE: you can use the ForceTagChange() function to trigger the MACHA driver to send the
tag value even when the value has not changed.

4 N

- _ P
= Machine e
U ..........
EcoStruxure Server URL
Machine Advisor "L EcoStruxure Machine Advisor
Token Machine Specific Data points

\ Internet /

ETH2: 175.172.0.225

s \VAVAVAY.
#X#AVAVAVA
A

AVAVA7A ATS
\ZAVAVATA
) "'¢X¢X7AVAVAV \VA7A

PFXSTM6B0OODIOT

Proface

\VAVAVAY.
Auv‘nnuunuu

perdt i] o) @i

Buﬁen Studio
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7. EcoStruxure Machine Advisor Configuration

EcoStruxure Machine Advisor Machine Connection

To establish a connection to EcoStruxure Machine Advisor you will need the following:
*  EcoStruxure Machine Advisor Account
«  Purchaser Configured in Organization settings.
* Registered Machine
* Server Address
+ Token

1. Sign in to EcoStruxure Machine Advisor https://ecostruxure-machine-
advisor.se.app/welcome

2. Follow the steps shown in the tutorial video to create a new Registered Machine
https://youtu.be/g4hNIOK62HO

3. Select the machine and go to the configuration page [ Monitor ] -> [ Config ].

FLEET OVERVIEW

Filter by: [0 offline only O warning only Filter by type ¥

Total machines: 1

0a

T
FLEET EDGE BOX DEMO - ORIGINAL D Global search
Applications  History  Graph  Values Consumptions

MACHINE: Edge Box Demo - Original

MONITOR CONFIGURATION Help



https://ecostruxure-machine-advisor.se.app/welcome
https://youtu.be/g4hNI0K62H0
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7. EcoStruxure Machine Advisor Configuration

EcoStruxure Machine Advisor Machine Connection

4. Select Mode: [ Connect your machine ]
5. Select Plan: Select your appropriate plan. For example, [ Pay As You Go ]
6. Select Gateway: [ Custom ]
7. Select Format: [ Tango ]
8. Select Transport: [ HTTPs ]
(] Scieider

MACHINE: Edge Box Demo- Original
MONITORCONFIGURé Help

i MODICON HARMONY ETIC EWON HILSCHER

ect Gateway le Node-RED Document
Custom ~ | frango

Genera tion

Protocol? | wrr

Custom header 1 | contentTypesapplicationfison ] MOXA TITAN
Configuration Steps Configuration Steps
Server: | hitps:/jenm-ih-na.azure-devices.net/dev | [0
©®©

Connection string;

9. Click [ +New Token ], leave the duration as default (10 years) and [ Create ] to create a

new token.

Create a new token

Select duration *

10 Years v

10. Generate new token, check the “I confirm...” check box to generate a new token and click
[ Yes].

Generate new token

Are you sure that you want to generate a new token?

[ | confirm | want to generate a new token_]

mu
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7. EcoStruxure Machine Advisor Configuration

EcoStruxure Machine Advisor Machine Connection

11. Copy the string in Server box and paste it on Notepad.
12. Copy the string in Token box and paste it on Notepad.

Generated Configuration

Protocol: | HTTPS POST (JSON) | |_|:|

Custom header 1: | Content-Type;application/json | |_|:|

Server: —‘—WWH |_|:| ]

Connection string: | | L O]
+ New Token

The last generated token is valic|for 9 Years 11 Months 30 Days.

Success! »

Token: . ' |[@

& Warningf Make sure you copy the above token now.
We do nqt store it and you will not be able to see it again.

File Edit View Help

https://enm-ih-na.azure-devices. net/devices/urn%3Adev% 3Aops % 3A000000-EMA-prod-
XXXX/messages/events?api-version=2016-11-14

Authorization;SharedAccessSignature sr=cnm-ih-na.azure-devices.net%2Furn%3Adev%3Aops%3A0OOOOO-EI\MOd-
1:9.9.9.9.9.0.0.0.99.90.0.000090099000.000T0)0.0.0.0.0.99990¢6.6.60011-009.9.9.9.9.9.0.0.0.¢
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7. EcoStruxure Machine Advisor Configuration

BLUE Open Studio Project Settings

1. Launch a Web Browser on your PC and Go to https://curl.se/docs/caextract.html

2. Download the “cacert.pem’ file.

3. Rename the file as “macha.pem”.

4. Copy “macha.pem” to the driver directory. For example for a default installation
C:\Program Files (x86)\Pro-face\BLUE Open Studio 2020\Redist\loTView\Linux\arm-
gnueabihf-2.13-6.0.17\drv

Y/ curl - Extract CA Certs from Moz X -+ [+ o x
& C {} & curlse/docs/caextracthtml oA % » a
Docs Overview Project Protocols Releases Tool Who and Why
curl f Docs / Protocols / CA Extract
CA certificates extracted from Mozilla
The Mozilla CA certificate store in PEM format (around 200KB uncompressed): Related:
SSL Certs
This bundle wa t Thu Sep 30 03:12:05 2021 GMT.
This PEM file contains the datestamp of the conversion and we anly make a new canversion if there's a change
in either the script or the source file. This service checks for updates every day. Here's the sha256sum of the
current PEM file.
File name
Some programs will expect this file to be named ca-bundle.crt (in the correct path). curl on windows has a
system to find it if named curl-ca-bundle.crt.
CA file revisions per date of appearance
Date Certificates
2021-09-30 127
2021-07-05 128
2021-05-25 127
2021-04-13 129
021.01.19 129 =
C:\Program Files (x86)\Pro-face\BLUE Open Studic 2020\ Redist\loTView\Linwx\arm-gnueabihf-2.13-6.0.17drv
Mame - Date medified Type Size
:E] abcip.ini 2021-04-27 9:31 AM Configuration sett... 1KB
|:] abcip.msg 2021-04-27 9:31 AM MS5G File 2 KB
|:] abcip.so 2021-04-27 9:31 AM 50 File 409 KB
:E] abtep.ini 2020-12-09 8:41 PM Configuration sett... 1KB
[ abtcp.msg 2020-12-09 &:41 PM MSG File 2KB
|:] abtcp.so 2020-12-09 8:41 PM 50 File 584 KB
:E] macha.ini 2021-09-28 1:02 AM Cenfiguration sett... 1KB
|:] macha.msg 2021-09-28 1:02 AM MSG File KB
2022-02-02 11:06 AM PEM File 209 KB
|_1 macha.so 2021-09-28 1:02 AM S0 File Q43 KB
:E] melse.ini 2021-10-22 8:41 AM Configuration sett... 5KB
|:] melse.msg 2021-10-22 8:41 AM MSG File 1KB



https://curl.se/docs/caextract.html
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7. EcoStruxure Machine Advisor Configuration

BLUE Open Studio Project Settings

5.  In BLUE Open Studio, {Project Explorer] -> [Comm] tab, right-click drivers and select
[Add/Remove Drivers].

File Home View Insert Project Help
K — b- Run | Download [~
[] =) C = ®
k| W Stop P Run
Runtime Connect Runtime Watch LogWin
,D Find/Replace Tasks & Debug - M Stop Tasks
Clipboard Laocal Management T« Remote Management ]
Project Explorer > B ox

~v & Project: EdgeBoxHMI QuickStart. APP
| Drrivers l

OPCD| ® Add/Remove drivers ]
> OPC UA
TCR/IP

6. Locate the [DLL] called [MACHA] and click to select it, then click [Select >>].

Communication Drivers

Available drivers:
DLL Description - Help

KO0 Directlogic Koyo, CCMAECOM protocol (DL240/DL2S0+H2-ENET)CE] [+1.25]
Ll L&l - Dizplay Larnix (CE) [+1.08]

LLIME. Communication driver for Enersafe Lifelink Device [CE] [+1.1]
LOPER LOPER -Protocolo de comunicacio CTE-100/04-MEC/CELESC [v1.0]
MACHA MACHA - Machine Advizor [+1.4] ]
= 5 TCETTva]
e

Selected drivers:

DLL Description

Cancel

7.  Click [OK] to close the [Communication Drivers] dialog.

Communication Drivers

Available drivers:
DLL Description - Help

kOv0 DirectLogic Koo, CCMAECOM protocol [DL240/DL280+H2-EMET)ICE] [+1.25]
Laibdli Laibdl - Dizplay Lamix (CE] [+1.08]

LLIME. Communication driver for Enersafe Lifelink Device [CE] [+1.1]

LOPER LOPER -Protocola de comunicagdo CTE-100/04-MEC/CELESC [+1.0]
MATS MATSUSHITA - FP1-Cax (CE] [+1.8]

MEBLAL MICROBLAL, TD3000 [CE) [2.00]

4 » Select =

Selected drivers:
DLL Description
MACHA MACHA - Machine Advizor [v1.4]

Cancel
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7. EcoStruxure Machine Advisor Configuration

BLUE Open Studio Project Settings

8. Navigate to [ Project Explorer] -> [ Comm ] tab -> [ Drivers ] -> [ MACHA ] -> [ MAIN

DRIVER SHEET ]

File Home View Insert Project Help
X cut ] P Run 4 Download [=2 F=1 [ & mport wizard — (@2 Replace &)
ol > = © ] R §
[ copy W stop P Run £3 Convert Resolution <% Remove unused tags 7
Paste Runtime Connect Runtime Watch LogWin WVerify Archive Global
,O Find/Replace Tasks & Debug ~ M Stop Tasks B}? Register Controls Replace @ Reset tags database =
Clipboard Local Management & Remote Management K] Tools K] Tags
Pr’Oject E}(plor’er - I X W MACHA - MAIN DRIVER SHEET =
v & Project: EdgeBoxHMI QuickStart. APP Desciiption
v Drivers
v MACHA Disable
MAIN DRIVER SHEET
DR Chent (leg
5 OPC UA Read Completed: Read Status:
TCR/IP
‘Write Completed: Wirite Status:
Tag Name | sttion | 110 Address | Aion | Sean | Dwv |  Add
Q Fitertext Q Fittertext Q Fitertext Qo@n v Qoan v Qriterten  Q Fitertex
Read+Write ¥ | Always b
* Read+\Write ¥ | Always v
* Read+Write ¥ | Always v
Read+Write ¥ | Always A
/P Global [A]Graphics [E Tasks |E& Comm

9. Enter the [Tag Name] = My Data, [I/O Address] = |:200 and copy/paste the Station
address from notepad into the [Station] field.

W MACHA - MAIN DRIVER SHEET x

L L L Ty

Description:
Disable:
Read Completed: Read Status:
White Completed Wite Status
| Tag Name Station | /0 Address | acion | Scan | Div | Add
Q, Filter text J Q, Filter text Q (am v QL an v | Q Fittertext | Filter text
1| MyData I https:icnm-ih-na. I'QDD I v ~
zure-devices.net/d
evices/urn%3Adey|
%3A0ps%3AD000
00-EMA-prod-X300s
XO0000CO00CGK <—
HOOO0Umessages
slevents?api-versi
0n=2016-11-14httg
s.dicnm-ih-na.azur Read+Write Always

File Edit View Help

. XXXX/messages/events?api-version=2016-11-14

f https://cnm-ih-na.azure-devices.net/devices/urn%3Adev%3Aops% 3A000000-EMA-prod-X XXX X

S

Authorization;SharedAccessSignature sr=cnm-ih-na.azure-devices.net%2Furn%3Adev%3Aops%3A000000-EMA-prod-
HOXOXXKKK K KKK K Eesiig =X OO XX XK XXX X &se=X XXX XXX XXX
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7. EcoStruxure Machine Advisor Configuration

BLUE Open Studio Project Settings

10. Right Click on [ MACHA ] and Select [ Settings ].
11. Set Prefix String: ANY, e.g. EdgeBoxHMIQuickStart
12. Select JSON Format: [ Tango ]

13. Click [ Authentication ]

Project Explorer v 1 x

wv & Project: EdgeBoxHMI
v Drivers

==
OPC .

TCRY] Help

Serial
Encapsulation:

Serial Port

Thread c Prefix string:
| EdgeBoxHMIQuickStar]
v
JSON format: Prm:y
Tango v
| anced |[| Authentication |] 0K | | Cancel

j?GIobaI [@l Graphics [E Tasks |ZE Comm

14. Copy URL and overwrite Station field.
15. Copy Token (after “Authorization;”) and overwrite the Password field.

16. Click [ OK] mnentiction »

Driver authentication information

tat ‘Username
https:ficnm-ih-na.azure-devices.n..

i

Fl\e Edit View Help

https://cnm-ih-na.azure-devices.net/devices/urn%3Adev%3Aops % 3A000000-EMA-prod- XXXXXXXXXXXXXXXXXXXX
XXXX/messages/events?api-version=2016-11-14

Authorization;SharedAccessSignature sr=cnm-ih-na.azure-devices.net%2Furn%3Adev%3Aops%3A000000-EMA-
10.9.9.9.0.0.9.9.0.9,.9.09.9.90999.099000 (- T-:[0.0.9.0.99.00.00.0.0.0900011-0.0.9.0.9.9,9.0.9,9.4
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7. EcoStruxure Machine Advisor Configuration

BLUE Open Studio Project Settings

17. Click [ OK ] to close the MACHA driver settings.

None -

COK1

Prefix string:
EdgeBoxHMIQuickStari

Proocy:

Authentication Cancel

Project Explorer v 1 x
v % Project: EdgeBoxHMI QuickStart. APP
v Drivers
v MACHA
{¥ MAIN DRIVER SHEET Serial
OPC DA Client (legacy) Encapsulation:
COPC UA Serial Port
TCR/IP
Thread count:
1
JSON format:
Tango
_f? Global [A] Graphics [ Tasks | %8 Comm

17

18. Transfer both the Runtime (to include macha.pem) and Project files to the Edge Box HMI

as shown in Section 5.
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8. AVEVA Insight Configuration

Overview

The Edge Box HMI can use a Trend Logger worksheet to communicate to an AVEVA Insight
account. A Data source definition is required in AVEVA Insight. Trend Logger data is logged
every 5 seconds. Accumulated data is forwarded to AVEVA Insight every 15 seconds.

-

AVEVA
Insight

\_

~

Data Source

AVEVA lnsig htDa-ta :Sou rce

]
-—
.1.Endpoint URL
Token

Internet /

PFXSTM6B00ODIOT

ETH2: 175.172.0.225

ATl oK TAATATATAT

AZAVAVAY o
FATAVATA
AVAVAVAZAVA /ATOTS (G 7A7
ROTOS AIAT TATA
mr

Proface

A7AVAVAVAVA7AT.
aaﬁuunuupn
e |3 G @i

Eju;;en Studio

L
pezav [

Forwarder — 15 seconds

& TrREnDOOZ.TRD x
Description:

AVEVA Insight

History Format:

Historian

Historian Configuration... Advance:

] Save On Trigger.

o drend Logger

Tag Name Dead Band Historian Tag

“-’% Filter text % Filter text &, Filter text
1 AVEVA_Insight_Data Production_Target Production_Tar
get

Scheduler - 5 seconds
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AVEVA Insight Configuration

AVEVA Insight Connection

To establish a connection to EcoStruxure Machine Advisor you will need the following:

+ AVEVA Insight Account and Solution
* AVEVA Insight Data Source

*  Upload Endpoint

*  Authentication Token

SIGN-IN to AVEVA Insight ( https://insight.connect.aveva.com ) and create a solution.

Navigate to AVEVA Insight Suite -> [ Administration ]

AVEVA™ Insight (TRaL@)

AVZVA INSIGHT

3. Navigate to [ Data Sources ]
= AVEVA™Insight (TR a O S ]
Administration
Users ;" Data Sources g Tag Dictionary ‘ Engineering Units h.‘ Integration Settings Tl
4. Click [ +]icon and select [ CSV/JSON ]
= AVEVA™Insight (Trac 2 Q0 H O

Data Sources

,,,,,,,,,,,,,,,,,,,,,

5.

Enter Name, Location Name, etc. and click [OK]

Add CSV/JSON Data Sour:

o The following fields will apply to al

£z Location

s, but do not apply to existing tags.

Select a location or type a new one
Japan

@ Geolocation Coordinates

If you define a new default location, it will be created when the first new tag using this default is created

v

CANCEL | OK



https://insight.connect.aveva.com/
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8. AVEVA Insight Configuration

AVEVA Insight Connection

6. Copy the text in “Upload endpoint” field and “Token” field and paste them into Notepad,
then click [ CLOSE ]

Upload to EdgeBoxHMI1 data source
Upload endpoint @

hﬁps://online.wonderware.com/apis/uploa

Token @
Bearer eyJhbGciOiJSUzITNilsInR5cCl6lkp X ClsimtpZCl6ImYyZGQ5Mzkz r[:]

You can upload 1 file per second.
To improve throughput, try grouping your records fito a smaller number of files.

DOWNLOAD SAMPLE FILE | CLOSE |

File Edit View Help '

https://insight.connect.aveva.com/apis/upload/datasource

4 )

Bearer
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8. AVEVA Insight Configuration

BLUE Open Studio Project Settings

1. [ Project Explorer ] -> [ Tasks ] Tab
2.  Right-Click Scheduler -> Click [ Insert ]

File Home View Insert Project Help
X = b Run =] 4 = @
|:| [Tk} 7® M stop D = O\
Runtime Connect ‘Watch LogWin
JO Find/Replace Tasks o Debug ~
Clipboard Local Management N Remote Management ]
Project Explorer > 2ox

v ¥ Project: EdgeBoxHMI QuickStart. APP
Alarms
Trend Logger
Recipes
Reports
Math

ip
Scheduler
> I Daiabase

?

j?GIabal Graph\cs =) Tasks Comm

3. Inthe first row [ Time ] Field enter 00:00:05

4. Inthe first row [ Tag [ Field enter “TrendLoggerTrigger” if prompted to create a new tag
click [ Yes ], then click [ OK'].

5. Inthe [ Expression ] field enter “Toggle(TrendLoggerTrigger)”.

L3 SCHEDOO1.SCH  x

Description:

| Event | Trigger | Time | Date | Tag Expression | Disable
[ Q v |Q Filterte ‘%anrt Q Fitter text | Q, Filter text Q Filter text QFmerten
1 Clock ] DEI 00:05 [TrendLoggerTrlgger ]JToggle(‘l’rendLoggerTrlgger}-

[+ Clock
[ Clock
[ Clock
[ Clock
[+ Clock

L €| €| €| £

6. Save the worksheet. If prompted, enter “1” as the [ Sheet number ]

Sheet number:

K Cancel
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8. AVEVA Insight Configuration

BLUE Open Studio Project Settings
7. Close the [ SCHEDO001.SCH ] worksheet
8. Right-Click Trend Logger -> Click [ Insert ]

File Home View Insert Project Help
X = } Run (=] + = @
D ] 7® W Stop © = Q
Runtime Connect Watch LogWin
O Find/Replace  Tasks X Debug -
Clipboard Local Management e Remote Management (]
Project Explorer v 2%

v & Project: EdgeBoxHMI QuickStart. APP

arm
Recipes
Reports
Math

> Script

> Scheduler

> Database/ERP

9. Change the [ History Format ] to [ Historian ].
10. Click [ Historian Configuration ]

|E3 TRENDOO1.TRD ¢

Description:

History Fommat;
| Historian - |][ Historian Configuration;]

| Save On Trigger:

Advanced...

Save On Tag Change

Second

| Tag Mame | d Historian Tag
Q. Filter text Q Fittertext | Filter text
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8. AVEVA Insight Configuration

BLUE Open Studio Project Settings

11.Set the [ Connection Type ] to [ AVEVA Insight (CSV/JSON) ]

12.Copy the Endpoint URL from notepad and paste overwriting the [ Upload Endpoint ]
13.Copy the Token from notepad and paste overwriting the [ Authentication Token ]
14.Click [ OK ] to accept the historian settings.

Connection Settings

Connection Type: | AVEVA Insight (CSV/JSON) -

thnd-“’[ https: ffinsight.connect. aveva.com/apis/upload/da tasuurce]

Authentication Token: [ Bearer eyJhbGaiOSUzI INISInR ScCl6IkpXVCIsImtpzclslr <

Max Forward Perod: 15 seconds

Database Settings
Prefix:

Run+ime

Status: Reload

Local Storage Limits
Max File Size: 1024 KB Max Files: 5

0K Cancel

File Edit View Help

https://insight.connect.aveva.com/apis/upload/datasource
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8. AVEVA Insight Configuration

BLUE Open Studio Project Settings

15.Set the [ Description ] to “AVEVA Insight”
16.Replace [ Second ] with [ TrendLoggerTrigger ]
17.Set the first row [ Tag Name ] to [ MyData ]

18. Set the first row [Historian Tag ] to [ MyData ]

|E3 TRENDOD1.TRD

Description:
[ ANEVA Insight ]

History Format:
Histarian -

Corfiguration... Advanced...

| Save On Trigger: Save On Tag Change

[ TrendLoggerTrigger

| Tag Mame | Dead Band Historian Tag
Q. Filter text Q Fittertext | Q, Filter text
MyData ] MyData

19.Save the [ Trend Logger ] worksheet, if prompted set the [Sheet number] to 1.

Sheet number:

oK Cancel

20. Transfer the project files to the Edge Box HMI as shown in Section 5.
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9. Database Configuration

Overview

The Edge Box HMI can use a Trend Logger worksheet to log data to a Microsoft SQL Server
Database. Trend Logger data is logged every 1 seconds. Each time the trend logger sheet is
triggered data is sent via the Studio Database Gateway which contains the communication
driver for Microsoft SQL Server. The Studio Database Gateway establishes a connection to
the database on behalf of the Edge Box HMI and logs the data to a table called TRENDOO2.

Microsoft SQL et et e T
i Stamp]
Server Database et
:[parg ] n-t
B
FROM [EdgeB: TH.

1t]

crosoft SQL Server

MyPCName\SQLEXPRESS
0% -
8 fee 8 atabase
Time_Stemp Time_Stamp_ms  Processed_Count  Unprocessed_Count  Passed_Count  Rejected_Count  Pari_jam  Process_unning
Database Name 1 [ 305504 1335717 0000000 | 475 27 ¥ 19 8 [ [
2 202204730357120000000 521 = % 19 7 ] ]
3 2020413035707.0000000 45 2 % 1 7 3 3
4 2020413035702.0000000 535 2 100 hid 7 0 0
Username
Password

y

[ Studio Database Gateway ]

PCIP: 192.168.1.70
Port 3997 Open

NV

[EaTRENDOOI.TRD %

Description:
Database

Eth1: 192.168.1.80 Database Configuration... Advanced..

i Save On Trigger: Save On Tag Change

Dalabase_tuntml.\;frﬂﬂyé n d Log g e r

Ta r S eefd | Field
| QFitertex LFiterted | Filter text
PFXSTM6BOO DIOT 1 Database_Data.Processed_Count Processed_Co
unt
|| Proface | 2 Database_Data.Unprocessed_Count Unprocessed_
FAVAVAY. Count

VA#AVAVAVA vy

Open Studio

50|
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9. Database Configuration

Overview

A simple configuration would have both the SQL Server instance and the Studio Database
Gateway installed on the same Windows PC. The PC is configured with an IP Address of
192.168.1.70

For example, SQL Server 2019 installed on a Windows 10 PC with the following:
— Path to SQL Server = PCNAME\SQLEXPRESS
Database name = EdgeBoxHMI

Mixed mode authentication with a local user account as db_Owner for the
EdgeBoxHMI database and login rights

Username = EdgeBoxHMI
Password = !Proface1234

On the same PC as SQL Server the Studio Database gateway is installed and running on port
3997.

PC Firewall(s) open for port 3997 for access to the Studio Database Gateway.

PC IP: 192.168.1.70

Edge Box HMI

Connection .\\$~§ ﬂﬂﬁ %
~

i
Firewall(s)

Studio Database SQL Server
Port 3997 Open Gateway

Microsoft
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9. Database Configuration

Create a SQL Database

This procedure assumes there is not an existing database for use with the project.

This database setup is for demonstration purposes only. Please ensure the appropriate
security measures are taken before deploying any database in a production
environment.

1. Start [ Microsoft SQL Management Studio]

2. If you followed the previous section’s instructions and the current Windows user account is
an administrator for SQL, leave the [ Connect to Server ] dialog settings as default and
click [ Connect]. If not, enter the correct Server name and Authentication details.

of Connect to Server >

SQL Server

Server type: Database Engine -
Server name: B DOMNSS0 w
Authentication: Windows Authertication W

DESKTOP-EZJOONSWPEX

. Cancel Help Options ==

3. [ Object Explorer ] -> [ Databases ] right-click [ Databases ] and click [ New Database... ].

,_Q Microsoft SOL Server Management Studic
File Edit View Tools Window Help
co-0 |8 0-2 E | B NewQuey B

| | Execute

Object Explorer > @1 X
Connect~ ¥ *¥ (R
£ i@ DESKTOP-E2JO0ONS\SOLEXPRESS (SQL

Secu [ Mew Database... j

Servg Attach...
Repli

Polyl
Man Restore Files and Filegroups...

Restore Database...

[f] Xeve Deploy Data-tier Application...

Impert Data-tier Applicatien...

Start PowerShell

Reports

Refresh
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9. Database Configuration

Create a SQL Database
4. Enter the Database name as “EdgeBoxHMI”

5. Click [OK ]
B Mew Database — O e
Selecta page HScriptveHelp
F General
J Options ~
# Filegroups Database name: [|EdgeBoxHMI| |I
Owner: |<defa|.||t> |
Database files:
Logical Mame  File Type  Filegroup Autogrowth / Maxsize Pa
EdgeBoxHMI ROWS.. PRIMARY 64 MB, Unlimited | €
EdgeBoxH... LOG Mot Applicable By 64 MB, Unlimited .| C]
Conneclion

Server:
DESKTOP-E2JOONS\SGLEXPRE

Connection:
DESKTOP-E2JOONSWPFX

ﬁ \iew connection properties

Ready <
Add ove

l oK il Cancel

6. [ Object Explorer ] -> [ Security ] -> [ Logins ] right-click [ Logins ], click [ New Login... ]

I_Q Microsoft SOL Server Management Studio
File  Edit View Tools Window Help
-9 |8-a-2

Object Explorer

Connect= ¥ *¥ T G

B i@ DESKTOP-E2JOONS\SQLEXPRESS (SQL
= Databases
System Databases

Database Snapshots
g EdgeBoxHMI
=] Security

BHEE

[ MNew Legin...

Filter

Start PowerShell
Reports
Refresh
Management

{#] XEvent Profiler
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9. Database Configuration

Create a SQL Database

7. Enter a Login Name: EdgeBoxHMI

8. Select [ SQL Server Authentication ]

9. Enter a password and confirm the password: |SE1234
10. Uncheck [ Enforce password policy ]

11.Change the [ Default Database ] to [ EdgeBoxHMI ]
12.Select the [ User Mapping ] page.

| Login - Mew
Selecta page LT Scipt ~ @ Help
& General
& Server Roles
& User MEEE""@ ' Login name: IEdgeBo:HMI I
& Securables i o
B Status () Windows authentication
[@ SGL Server authentication
Paszward: I I
Confirm password: ressane J
[|:| Enforce password pnlic:.']
() Mapped to certificate
(") Mapped to asymmetric key
Map to Credential
] Mapto ia
Server Mapped Credentials Credertial Provider
DESKTOP-E2JO0NSSCOLEXPRE
Connection:
DESKTOP-E2JOONSWPFX
ﬁ View connection properties
Progress
Ready Default database: [EdgeBa:HMI
Default language: <default

Add
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9. Database Configuration

Create a SQL Database

13.Check [ Map ] for the [ EdgeBoxHMI ] database

14.Check [ db_owner ]

15.Click [ OK ]
B Login- New - O
Selectapage
& General
& Server Roles
¥
& Securables User Defautt Schema
& Status EdgeBoxHMI
Connection =
Server: - o
DESKTOP-EZJOONS\SQLEXPRE Database role membership for: EdgeBoxHMI
Connection: [] db_accessadmin
DESKTOP-E2JOONSWPFX [] db_backupoperator
v¥ View connection properties [] db_datareader
[] db_datawriter
[ db_ddiadmin
[] db_denydataread
it
Progress db_owner
—secunyadmin
Ready public
ok ]| ce
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9. Database Configuration

Studio Database Gateway Installation

To allow the HMI runtime running on the Edge Box HMI to communicate with SQL Server the
Studio Database Gateway needs to be installed on a Windows PC on the same network as the
Microsoft SQL Server. For an easy demonstration configuration, install the Studio Database
Gateway on the same Windows PC as the Microsoft SQL Server Database.

If BLUE Open Studio is already installed on the Windows PC, the Studio Database Gateway is
already installed in the BLUE Open Studio BIN directory. The default path would be:

C:\Program Files (x86)\Pro-face\BLUE Open Studio
2020\Bin\DatabaseGateway\StADOSvr.exe

Skip to STEP 11 if BLUE Open Studio is already installed. Otherwise install the Studio
Database gateway by starting at STEP 1.

1. If not already installed on the Microsoft SQL Server Windows PC, install .NET Framework
3.5 via [Turn Windows features on or off ].

2. On the BLUE Open Studio development PC copy the [ GatewaySteup.exe ] from
C:\Program Files (x86)\Pro-face\BLUE Open Studio
2020\Redist\DatabaseGateway\GatewaySetup.exe to the Windows PC that has
Microsoft SQL Server installed.

3. Run the GatewaySetup.exe
4. If prompted to install redistributables, click [ Install ]

Pro-face BLUE Open Studic Database Gateway 2020 - InstallShield Wizard

< Pro-face BLUE Open Studio Database Gateway 2020 requires the following items to be
installed on your computer, Click Install to begin installing these requirements.

Status  Requirement

Pending Microsoft Visual C++ 2008 SP1 Redistributable (x86) 9.0.30729.6161
Pending Microsoft Visual C++ 2010 Redistributable Package (x88)

Pending Microsoft Visual C++ 2012 Redistributable - x86 version 11.0.61030.0
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9. Database Configuration

Studio Database Gateway Installation

5. Click [ Next ].

Pro-face BLUE Open Studic Database Gateway 2020 + Service Pack 2 x

Welcome to the InstallShield Wizard for Pro-face
BLUE Open Studio Database Gateway 2020

The InstallShield Wizard will install Pro-face BLUE Open
Studio Database Gateway 2020 on your computer.

Itis recommended that you dose all other applications
before starting the Setup. This will make it possible to
update relevant system files without having to reboot
your computer,

Click Mext to continue.

< Back

6. Enter a[ User Name ] and [ Company Name ]
7. Click [ Next ]

Pro-face BLUE Open Studic Database Gateway 2020 + Service Pack 2

Customer Information

Please enter your information.

")

Please enter your name and the name of the company for which you work.

User Mame:

| MyUsername

Company Mame:

| MyCompanyNamd
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9. Database Configuration

Studio Database Gateway Installation

8. Click [ Next].

Pro-face BLUE Open Studio Database Gateway 2020 + Service Pack 2 >

Choose Destination Location

Select folder where setup will install files. \
Setup will install Pro-face BLUE Open Studio Database Gateway 2020 in the following
folder.

To install to this folder, dick Mext. To install to a different folder, dick Browse and select
another folder.

Destination Folder

C:\..\studio Database Gateway 2020

9. Click [ Next]

Pro-face BLUE Open Studic Database Gateway 2020 + Service Pack 2 x

Select Features
Select the features setup will install,

w

Select the features you want to install, and deselect the features you do not want to install.

..... Description

Installs main files.

35.58 MB of space required on the C drive
20673.87 MB of space avaiable on the C drive
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9. Database Configuration

Studio Database Gateway Installation
10. Click [ Install ].

Pro-face BLUE Qpen Studic Database Gateway 2020 + Service Pack 2 it

Ready to Install the Program
The wizard is ready to beqin installation.

-

If you want to review or change any of your installation settings, dick Badk., Click Cancel to

Click Install to begin the installation.

exit the wizard.

11.Create a firewall exception for the Studio Database gateway which uses port 3997. For

example configure Microsoft Windows Defender Firewall and any other security software
that would block communication.

12.Set the IP Address of the Windows PC that is running the Studio Database Gateway to
192.168.1.70

Internet Protocel Version 4 (TCP/IPvd) Properties =

General

You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(C) Obtain an IP address automatically
(@) Use the following IP address:

IP address: 192.168. 1 .70
Subnet mask: 255 .255.255. 0

Obtain DNS server address automatically

(®) Use the following DNS server addresses:

L ]
]

Preferred DNS server:

Alternate DNS server:

[Jvalidate settings upon exit Advanced. .

Cancel
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9. Database Configuration

Studio Database Gateway Installation

13. Start the Studio Database Gateway Manually or set the program to autostart on Windows
log in using a shortcut in the startup folder, task scheduler, registry or other method to auto
start a program in Windows.

To manually start the Studio Database Gateway on a Windows PC without BLUE Open
Studio installed, execute: C:\Program Files (x86)\Studio Database Gateway
2020\StADOSvr.exe

To manually start the Studio Database Gateway on a Windows PC with BLUE Open
Studio installed, execute: C:\Program Files (x86)\Pro-face\BLUE Open Studio
2020\Bin\DatabaseGateway\StADOSvr.exe

14. Confirm the Studio Database Gateway is running by checking for the Icon in the notification
area of the taskbar.

4:08 PM

3/6/2018

A ) El I::]]




9. Database Configuration

BLUE Open Studio Project Settings

1. [ Project] menu ->[ Options ]
2. Click [ Default Database ]

STM6000 Edge Box HMI Quick Start Guide

File Home View

0]

Studio Basig) =

Insert

Ea h

Project Explorer

v & Project: EdgeBoxHMI QuickStart. APP
Alarms
> Trend Logger

Recipes
Reports
Math

> Seript

> Scheduler

> Database/ERP

= 3% L B0 (%
Preferences E-Mail/FTP Configure Log Thin  Mabile

On Clients Access

Security System Web

Information Options Viewer Communication Preferences 4 B

E& Configure the default database, alarm/event settings, and target system

Target system

| Embedded BLUE Open Studio Basic -

Resolution: 1520x1080

BLUE Open Studic Basic for Linux (500 tags)

Alarm History and Events

History Format:
Proprietary

]

History Life Time (days):

Default Database...

Performance Control...

Custom Fields
Alarm: | 0

Event | O

Data Protection..

f? Global @ Graphics

& Tasks | 22 Comm

Watch
Tag/Expression | Value a V!
M 4 » W "DB1,/DB2/{DB3 / DB4 / Locals / Stack Frame / Tasks: 4 » H 4 » M LogW

3. Click[...]

4. Select [Microsoft OLE DB

Default Database Configuration
Settings

Connection string:

=)

User name:
Password:
Retry Interval: 120 Secs. Advanced. ..

Provider for SQL Server ] and click [ Next ]
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9. Database Configuration

BLUE Open Studio Project Settings

5.
6.

Enter the server name so that it matches the SQL server instance name.
Enter the user name and password if different (user name = EdgeBoxHMI, password

= ISE1234)

Check [ Allow saving password ]

Enter the database if different (EdgeBoxHMI)
Click [ OK]

EF| Data Link Properties

Provider Connection  Advanced Al

Specify the following to connect to SQL Server data:
1. Select or enter a server name:;

| [DESKTOP-E2J00NS\SQLEXPRESS v

2. Enter information to log on to the server:
(1 Use Windows NT Integrated security

(®) se a specific user name and password:
LIser name: || EdgeBoxHMI

Password:
[ ] Blank password Allow saving passward
3. (@) Select the database on the server;
| EdgeBoxHMI
() Attach a database file as a database name:
EdgeBoxHMI
I1zing the filenanme:

Test Connection

[ ok ]

Cancel Help

N

10.Click [ Advanced ]
11.Enter the Database Gateway Host and Port if different (Host = 192.168.1.70, Port = 3997)

12.Click [ OK ]

13 Clle [ OK ] Default Database Configuration
Settings
Database:  Primary -

Connection string:

User name: EdgeBoxHMI
Pazzword: *0080 00
Retry Interval: 120

Cancel

Prowider=SOLOLEDE.1; Initial Catalog=

|_5¢' Microsoft SOL Server Management Studio
File Edit View Tools Window Help

~o 8- -t E | B Newouey B

| Execute

Object Explorer

Connect~ ¥ ¥ ¢ =~

& DESKTOP-E2JOONSSOLEXPRESS ¢
Databases

System Databases
Database Snapshots

™) EdgeBoxHMI

Securitv

Time Stamp
Time Zone:

uTtc ~

Milizecor
Default

Database Gateway
Host: 192168.1.70 Port: 3337

Dizable Primary Keys Dizgable SQL variables

Disable Delimiters

Cancel
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BLUE Open Studio Project Settings

14.Click [ OK'] | re  rome

0]

View

Insert

DE PR =% PED A

Target System [BLUE Open Information Options Communication Viewer Preferences E-Mail/FTP

Project Help

Configure Log Thin  Maobile
Studio Basig) = on Clients Access
Settings r] Security System Web
. ) 5 5 X
Project Explorer AT ot setnos
= .,E Project: EdgeBoxHMI QuickStart. APP Information Options Viewer Communication Preferences 4 B
Alarms
¥ Trend Logger Q Configure the default database, alarm/event settings, and target system
Recipes
Reports
Math Target system
> Script | Embedded BLUE Open Studio Basic - Resolution: 1920x1080
> Scheduler
> Database/ERP BLUE Open Studic Basic for Linux (500 tags)
Alarm History and Events
History Format: Custom Fields
Proprietary - Alarm: | 0
History Life Time (days): Event | 0
0
Default Database... Performance Control... Data Protection...
/P Global (] Graphics | [ Tasks | 2.2 Comm
Watch
Tag/Expression | Value q Y
Cox J oo
4 4 » »DB1/DBE2/DB3 /DB4 / Llocals /. Stack Frame / Tasks:| 4

3 M 4 F K LogV

15.[ Project Explorer ] -> [ Tasks ] Tab
16.Right-Click [Trend Logger ] -> Click [ Insert ]

Project Explorer

/® Global Graphics

File Home View Insert Project

-

Target System [ELUE Open Information Options Cor
Studio Basic)

Settir

11

- x

v & Project: EdgeBoxHMI QuickStart.APP
Alarms

Trend Logge

Recipes

Insert

Reports

Math

Script
Scheduler
Database/ERP
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9. Database Configuration

BLUE Open Studio Project Settings

17.Change the [ History Format ] to [ Database ].
18. Click [ Database Configuration ]

|3 TRENDOOZ.TRD

Description:

History Format:
IDataba.se - |] [Databaseﬂ:nnfiguration...] Advanced...
| Save On Trigger: Save On Tag Change
Second
| Tag Mame | Dead Band | Field
Q Filter text Q Fitertet | Q Filter text

19. Confirm the Database setting are correct.
20.Leave [ Table ] Settings as default
21.Click [ OK ]

Database Configuration

| Use project default

Provider=5SGALOLEDE 1 ; Initial Catalog=
EdgeB oxHbI

\ 120

Table
| Uze default name | Automatically create

TREMDOD2

N

Run-Time

Status: Reload:

QK Cancel
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9. Database Configuration

BLUE Open Studio Project Settings

22.Set the [ Description ] to “Database”.
23.Enter “MyData2” into the first row [ Tag Name ] column. If prompted to create the tag

select [ Yes] and [ OK ]

24 Enter “MyData” into the first row [ Field ] column.

[E3 TRENDOOZ.TRD X%

Description:
[l Database ]
History Format:
Database - Database Configuration... Advanced...
| Save On Trigger: Save On Tag Change
Second
| Tag Mame | Dead Band Field
Q, Filter text Q Filtertet | Filter text
1 [yData ] |MyData |

25.Save the Trend Logger worksheet. If prompted, enter 2 as the [ Sheet number ].

Sheet number:

8] Cancel

26.Close the [ TRENDOO2.TRD ] tab.
27.In the [ Project Explorer ], Right-Click [ Math ] and Click [ Insert ]

Project Explorer v 1x

v & Project: EdgeBoxHMI QuickStart.APP
Alarms
> Trend Logger

Recipes

Reports

Math
> o Sai__nsert ]
> Scheduler

» Database/ERP
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9. Database Configuration

BLUE Open Studio Project Settings

28.In [ Execution ] enter “1”

29.Enter “MyData2” into the first row [ Tag Name ] column.
30.Enter “MyData” into the first row [ Expression ] column.

z MATHOO01.MAT [Language: Built-in] >

Description:

Execution:
L |

Tag Name | Exprezsion
Q Filter text Q Fitter text
q ||MyDataE ] |lru1yData

31.Save the Math worksheet. If prompted, enter 1 as the [ Sheet number ].

Sheet number:

oK Cancel

32.Close the [ MATHOO1.MAT ] tab.
33. Transfer the project files to the Edge Box HMI as shown in Section 5.
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10. Pro-face Connect Configuration

When using a PC or tablet to display and operate HMI products installed in remote locations, it
is necessary to build a system that prevents unauthorized access by external entities. By
installing Pro-face Connect (sold separately), you can build a secure remote access system.

Pro-face Connect consists of our products on the work site (SiteManager), computers or
tablets in the office (LinkManager), and a server to connect them (GateManager).

This section describes how to set up SiteManager.

How to set up

1. Log in to [Hardware Configuration].

2. Open [SITEMANAGER] tab and select [Enable Remote Management] check box.

3. Enter IP address of GateManager you want to access and the password (token)
to connect to GateManager. This information can be found at the bottom of
GateManager X.509 certificate emailed to you from GateManager.

Hardware Configuration U B

INFORMATION ETHERNET coMm usB DOWNLOAD SITEMANAGER SECURITY SYSTEM

Enable Remote Management ||
SiteManager Embedded Version 6141 621096032 (arm)

GateManager Address
Domain Token
Appliance Name
Proxy Address

Proxy User

Proxy Password

Factory Reset |

4. In Appliance Name, enter the name of the target device (the name of SiteManager). The
name set here is displayed on GateManager.

5. If required, enter the proxy server IP address, account name and password. For proxy
server information, consult your network administrator.

6. Click [Submit].
7. Click [Reboot] icon in the top-right corner of the screen. The product is restarted.
NOTE:

For more information about Pro-face Connect, refer to our website. https://www.pro-face.com

When you delete the registered SiteManager from GateManager, you need to initialize SiteManager and
reassign the license. Click [Reset to Default] and request the GateManager administrator to reassign the license.
(You cannot use the same license. Reissuing a license will take 24 hours.)
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